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Notices 

This document refers to Calnex Paragon-neo Software Revision 11.00.xx and higher.  
Last Updated: January 2024 

© Copyright Calnex Solutions plc, 2024. All rights reserved.  

 

Reproduction, adaptation, or translation without prior written consent is strictly prohibited, except as allowed under 
copyright laws. 

 
 

Warranty 

The information contained in this document is subject to change without notice. 

Calnex Solutions plc makes no warranty of any kind with regards to this material, including but not limited to, 
the implied warranties or merchantability and fitness for a particular purpose. 

Calnex Solutions plc shall not be liable for errors contained herein and for incidental or consequential damages in 
connection with the furnishing, performance, or use of this material. 

 

 

Warnings and Cautions 

 

WARNING  
A WARNING notice denotes a hazardous situation that, if not avoided, could result in death or 
personal injury. 

 

 

CAUTION  
A CAUTION notice denotes a hazardous situation that, if not avoided, could result in damage to, 
or destruction of, this equipment or other property. 

 

 

IMPORTANT  
Indicates information, procedures or recommendations that need to be followed to make correct 
measurements. 
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1 Introduction 

This guide shows you how to install and operate the Calnex Paragon-neo hardware and navigate the user 
interface.  

The operational guidance is generic, detailed operational steps for specific test scenarios and results 
interpretation can be found in the Calnex Test Guides and Software Release Notes available on the instrument. 

1.1 Overview 

Calnex Paragon-neo provides direct insight into the performance of high-accuracy timing signals at interfaces up to 
400GbE, and the ability to generate real-world scenarios to validate the operation and behavior of network 
devices. 

This guide describes all versions of the instrument: Paragon-neo first generation, Paragon-neo second generation, 
Paragon-neo R and Paragon-neo PAM4.  

Paragon-neo functions (with appropriate options installed): 

• Ethernet interface rates of –  

- NRZ ports: 100M, 1GbE, 10GbE, 25GbE, 40GbE, 50GbE and 100GbE. 

- PAM4 ports: 50GbE, 100GbE, 200GbE and 400GbE. 

• PTP timeTransmitter/timeReceiver emulation, impairments, and time error measurements to ITU-T G.826x and 
G.827x standards, including Class-C, Class-D and other Enhanced Timing devices. 

• PTP and Time of Day message decode and analysis. 

• SyncE wander tolerance, transfer and generation testing to ITU-T G.8262.1 and G.8262. 

• SyncE jitter tolerance and generation testing to ITU-T G.8262.1 and G.8262. Jitter testing available only on NRZ 
interfaces. 

• ESMC message generation and measurement to ITU-T G.8264. 

• 1PPS/ToD generation and measurement. 

• Background traffic generation. 
 

1.2 Terminology 

This document uses the following definitions: 

• Paragon-neo – a general description applying to both Paragon-neo NRZ and Paragon-neo PAM4 instruments. 

• Paragon-neo NRZ – an item or description specific to the Paragon-neo NRZ first or second generation 
instrument.  

• Paragon-neo R – an item or description specific to the Paragon-neo R instrument. 

• Paragon-neo PAM4 – an item or description specific to the Paragon-neo PAM4 instrument. 
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2 Installation 

The Paragon-neo is bench portable and operates stand-alone in a normal laboratory environment. If the Paragon-
neo is to be mounted in an equipment rack, either use the Calnex supplied rack mounting kit, or the Paragon-neo 
can be placed on an appropriately secured and weight rated shelf in the rack. 

Always position the equipment with unrestricted access to the AC power connector.  

The vents to the left and right sides of the Paragon-neo chassis must always be unimpeded to allow for the cooling 
of the internal components (airflow is left to right when looking at the front panel). Ensure that there is at least 
75mm unobstructed space on each side of the instrument to allow airflow. 

Environmental operating conditions must comply with the specifications in section 2.2.4. 

  

2.1 Supplied Accessories & Paperwork 

After unpacking the Paragon-neo, make sure that the accessories below are present. If anything is missing, contact 
Calnex Solutions by telephone: +44 (0) 1506 671 416 or by email: support@calnexsol.com 

• Power cord (1)  

• Getting Started Guide (1) 

• Declaration of Conformity (1) 

• CSS Brochure (1) 

• Customer Information Sheet (1) 

• Calibration Certificate (instruments fitted with Jitter measurement option only) (1) 

• Rackmount Instructions (1) 

• Packing List (1) 
 

2.2 Specifications and Operating conditions 

 

WARNING:  
Use of this equipment in a manner not specified by Calnex Solutions may impair the protection 
afforded by the equipment and invalidate the warranty. Note that there are no user-serviceable 
parts inside the Paragon-neo. The instrument should be returned to Calnex Solutions for all 
repairs. Unauthorized opening of the instrument will invalidate the warranty. 

 

 

WARNING:  
To prevent fire or shock hazard, do not expose the unit to rain or moisture. 

 

 

WARNING:  
To avoid electrical shock: 

• Use the only power cord supplied, or one with adequate ratings, and connect only to a 
properly grounded power socket outlet. Ensure the power socket outlet is easily accessible 
and near the unit. 

• Do not open covers. Refer servicing to qualified personnel only. 
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2.2.1 Dimensions 

Paragon-neo: 45cm x 40cm x 17cm (W x D x H). 

Cardboard Shipping Carton: 63cm x 60cm x 33cm. 

Carry Case: 63cm x 60cm x 33cm. 

 

2.2.2 Weight 

Paragon-neo: 13kg (max). 

Gross Packed Weight (shipping carton): 25kg (max). Paragon-neo plus Power Cord fitted in Carry Case with 
Cardboard Shipping Carton.  

Gross Packed Weight (carry case): 24kg (max). Paragon-neo plus Power Cord fitted in Carry Case. 

 

2.2.3 Power Requirements 

The unit requires a power source of: 

Voltage: 100 – 240V AC. 

Power: 800W max. 

Frequency: 50 – 60Hz. 

 

2.2.4 Environmental Conditions 

The environmental conditions the instrument is designed to support are as listed below: 

• For indoor use only 

• Altitude: Operating: ≤2000m 

• Operating temp: 0 – 40˚C 

• Relative Humidity: Operating: ≤90% non-condensing 

• Pollution degree of the intended environment: PD2 

• Mains supply voltage fluctuations: ±10% 

• Overvoltage category: OVC II 
 

2.2.5 Regulatory 

CE and EMC (incl. EN-61010, EN-61326, etc.) certified. 

• Safety: EN 61010-1:2010 +A1:2019, CAT II 

• EMC: EN 61326-1:2021 
 

2.3 Cleaning 

If the surface of the Paragon-neo becomes dirty, remove the AC power and clean with a soft lint-free cloth. Never 
use flammable liquids to clean the instrument. 

 

2.4 Shipping Packaging 

Paragon-neo is supplied in a carrying case. This case is designed and tested specially to protect your Paragon-neo 
during transport. Please retain for future use, as transporting in any other packaging will void the instrument 
warranty. 
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2.5 Labels and Disposal Information 

 

The Waste Electrical and Electronic Equipment regulations label indicates that the equipment 
should only be disposed of through an approved method. At the end of life please dispose of the 
equipment through a recognized and approved scheme fulfilling the local environmental 
requirements.  

 

The CE mark indicates that the product meets all the appropriate provisions of the relevant 
legislation contained in the European Directives. 
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3 Paragon-neo Front Panels 

3.1 First Generation Paragon-neo NRZ Front Panel 

First generation Paragon-neo NRZ instruments can be identified by the presence of two CFP4 transceiver ports on 
the front panel. 

 

 

 

  

On/Off Switch Optical Ethernet Ports 
SFP (P2, P9) 
SFP+/SFP28 (P3, P8) 
QSFP+/QSFP28 (P4, P7) 
100G CXP (P1, P10) 
100G CFP4 (P5, P6) 

Optical Ethernet Ports 100M SFP (P11, P14) 
Electrical Ethernet Ports 100/1000BASE-T (P12, P13) 

Clock Measurement Ports 
Balanced (P15) 
Unbalanced (P16) 

Measurement Ports  
1PPS+ToD Balanced (P17)  
1PPS Unbalanced (P18) 

Diagnostic Ports 
(unused) (J12, J13) 

Status Display 

USB (J11) 

LAN (J10) 

Reset Switch 

Unbalanced Clock  
Ref Output (J3) 

Ref Outputs 
1PPS+ToD Balanced (J4) 
1PPS Unbalanced (J6) 
 

Ref Inputs  
1PPS+ToD Balanced (J5) 
1PPS Unbalanced (J7) 

Test Outputs 
1PPS+ToD Balanced (J8) 
Unbalanced Clock (J9) 

Clock Ref Inputs  
Unbalanced (J1)  
Balanced (J2) 

Buttons 
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3.2 Second Generation Paragon-neo NRZ Front Panel 

Second generation Paragon-neo NRZ instruments can be identified by the presence of two high speed electrical 
(2.5G/5G/10G) Ethernet ports on the front panel. Second generation instruments do not have CFP4 transceiver 
ports. 

 

 

  

Diagnostic Ports 
(unused) (J12, J13) 

Status Display 

USB (J11) 

LAN (J10) 

Reset Switch 

Unbalanced  
Clock Ref Output (J3) 

Ref Outputs 
1PPS+ToD Balanced (J4) 
1PPS Unbalanced (J6) 

 

Ref Inputs  
1PPS+ToD Balanced (J5) 
1PPS Unbalanced (J7) 

Test Outputs 
1PPS+ToD Balanced (J8) 
Unbalanced Clock (J9) 

Clock Ref Inputs  
Unbalanced (J1)  
Balanced (J2) 

On/Off Switch NRZ Optical Ethernet Ports 
SFP (P2, P7) 
SFP28/SFP+ (P3, P6) 
QSFP28/QSFP+ (P4, P5) 

Clock Measurement Ports 
Balanced (P13) 
Unbalanced (P15) 

Measurement Ports  
1PPS+ToD Balanced (P14)  
1PPS Unbalanced (P16) 

Electrical Ethernet Ports 
2.5G/5G/10G (P1, P8) 

Optical Ethernet Ports 100M SFP (P9, P12) 
Electrical Ethernet Ports 100/1000BASE-T (P10, P11) 

Buttons 
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3.3 Paragon-neo R Front Panel 

Paragon-neo R instruments can be identified by the Paragon-neo R logo on the front panel. 

 

 

 

  

Diagnostic Ports 
(unused) (J12, J13) 

Status Display 

USB (J11) 

LAN (J10) 

Reset Switch 

Unbalanced  
Clock Ref Output (J3) 

Ref Outputs 
1PPS+ToD Balanced (J4) 
1PPS Unbalanced (J6) 
 

Ref Inputs  
1PPS+ToD Balanced (J5) 
1PPS Unbalanced (J7) 

Test Outputs 
1PPS+ToD Balanced (J8) 
Unbalanced Clock (J9) 

Clock Ref Inputs  
Unbalanced (J1)  
Balanced (J2) 

On/Off Switch NRZ Optical Ethernet Ports 
SFP (P2, P7) 
SFP28/SFP+ (P3, P6) 

Clock Measurement Ports 
Balanced (P13) 
Unbalanced (P15) 

Measurement Ports  
1PPS+ToD Balanced (P14)  
1PPS Unbalanced (P16) 

Electrical Ethernet Ports 
2.5G/5G/10G (P1, P8) 

Optical Ethernet Ports 100M SFP (P9, P12) 
Electrical Ethernet Ports 100/1000BASE-T (P10, P11) 

Buttons 
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3.4 Paragon-neo PAM4 Front Panel 

Paragon-neo PAM4 instruments can be identified by the presence of a second row of PAM4 transceiver ports. 

 

 

 

Diagnostic Ports 
(unused) (J12, J13) 

Status Display 

USB (J11) 

LAN (J10) 

Reset Switch 

Unbalanced  
Clock Ref Output (J3) 

Ref Outputs 
1PPS+ToD Balanced (J4) 
1PPS Unbalanced (J6) 
 
 

Ref Inputs  
1PPS+ToD Balanced (J5) 
1PPS Unbalanced (J7) 

Test Outputs 
1PPS+ToD Balanced (J8) 
Unbalanced Clock (J9) 

Clock Ref Inputs  
Unbalanced (J1) 
Balanced (J2) 

On/Off Switch NRZ Optical Ethernet Ports 
SFP (P2, P7) 
SFP28/SFP+ (P3, P6) 
QSFP28/QSFP+ (P4, P5) 

Clock Measurement Ports 
Balanced (P13) 
Unbalanced (P15) 

Measurement Ports  
1PPS+ToD Balanced (P14)  
1PPS Unbalanced (P16) 

Electrical Ethernet Ports 
2.5G/5G/10G (P1, P8) 

PAM4 Optical Ethernet Ports 
SFP56/SFP-DD (P17, P22) 
QSFP-DD/QSFP56 (P18, P21) 
CFP2 (P19, P20) currently not used 

Optical Ethernet Ports 100M SFP (P9, P12) 
Electrical Ethernet Ports 100/1000BASE-T (P10, P11) 

Buttons 
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4 Front Panel Controls 

Paragon-neo NRZ first- and second-generation instruments have different Ethernet port numbers as shown in the 
tables below. Paragon-neo NRZ second generation, Paragon-neo R and Paragon-neo PAM4 have consistent ports 
numbers for the Ethernet ports. All other ports (reference, measurement, management) have consistent port 
numbers across the Paragon-neo family. 

4.1 On/Off Switch 

Use this button to switch Paragon-neo On or Off. Switch off at the front panel before switching off the AC input on 
the rear panel. 

4.2 Ethernet Ports 

Optical Transceivers 

 

CAUTION  
Take care when inserting and removing transceivers from all ports. Excessive insertion and 
extraction force, leverage and vertical movement can permanently damage the internal circuitry. 

Direct Attach Cables (DACs) 

 

CAUTION  
Paragon-neo ports are designed for optical transceivers only. Direct Attach Cables, both active 
and passive, are not supported on any ports. Use of Direct Attach Cables can permanently 
damage the internal circuitry. 

100M/1G Electrical Ethernet ports 

100M SFP Ethernet 
ports 

Paragon-neo NRZ 1st gen: P11, P14 For connections to 100M NRZ 
interfaces on Ethernet devices. Paragon-neo NRZ 2nd gen, R, PAM4: P9, P12 

100M/1G Electrical 
Ethernet ports 

Paragon-neo NRZ 1st gen: P12, P13 For connections to 100M/1G RJ45 
electrical interfaces on Ethernet 
devices. Paragon-neo NRZ 2nd gen, R, PAM4: P10, P11 

Note: During a Boundary Clock Relative Time Error test, the Port 1 100M SFP port operates at 1G. Further details 
are given in the G.8273.2 BC Conformance Test Guide, document ref CX3009. 

 

2.5G/5G/10G Electrical Ethernet Ports 

2.5G/5G/10G 
Electrical Ethernet 
ports 

Paragon-neo NRZ 1st gen: n/a 
Contact Calnex for software support 
schedule. 

Paragon-neo NRZ 2nd gen, R, PAM4: P1, P8 

 

1G SFP Ethernet Ports 

1G SFP Ethernet ports 
Paragon-neo NRZ 1st gen: P2, P9 For connections to 1G NRZ optical 

interfaces on Ethernet devices. Paragon-neo NRZ 2nd gen, R, PAM4: P2, P7 
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SFP+/SFP28 Ethernet Ports 

10G SFP+ Ethernet 
ports 

Paragon-neo NRZ 1st gen: P3, P8 For connections to 10G NRZ optical 
interfaces on Ethernet devices. Paragon-neo NRZ 2nd gen, R, PAM4: P3, P6 

25G SFP28 Ethernet 
ports 

Paragon-neo NRZ 1st gen: P3, P8 For connections to 25G NRZ optical 
interfaces on Ethernet devices. Paragon-neo NRZ 2nd gen, R, PAM4: P3, P6 

 

QSFP28/QSFP+ Ethernet Ports 

40G QSFP+ 
Ethernet ports 

Paragon-neo NRZ 1st gen: P4, P7 
For connections to 40G (4 x 10G) 
NRZ optical interfaces on Ethernet 
devices. 

Paragon-neo R n/a 

Paragon-neo NRZ 2nd gen, PAM4: P4, P5 

100G QSFP28 
Ethernet ports 

Paragon-neo NRZ 1st gen: P4, P7 
For connections to 100G (4 x 25G) 
NRZ optical interfaces on Ethernet 
devices. 

Paragon-neo R n/a 

Paragon-neo NRZ 2nd gen, PAM4: P4, P5 

 

100G CXP Ethernet Ports 

100G CXP Ethernet 
ports 

Paragon-neo NRZ 1st gen: P1, P10 For connections to 100G NRZ 
optical interfaces on Ethernet 
devices. Paragon-neo NRZ 2nd gen, R, PAM4: n/a 

 

100G CFP4 Ethernet Ports P5, P6 – Do Not Connect 

100G CFP4 
Ethernet ports 

Paragon-neo NRZ 1st gen: P5, P6 Do not connect. 

These ports are not used. Paragon-neo NRZ 2nd gen, R, PAM4: n/a 

 

SFP56/SFP-DD Ethernet Ports 

50G SFP56 
Ethernet ports 

Paragon-neo NRZ 1st gen, 2nd gen, R: n/a For connections to 50G PAM4 
optical interfaces on Ethernet 
devices. Paragon-neo PAM4: P17, P22 

100G SFP-DD 
Ethernet ports 

Paragon-neo NRZ 1st gen, 2nd gen, R: n/a For connections to 100G PAM4 
optical interfaces on Ethernet 
devices. Paragon-neo PAM4: P17, P22 

Note: PAM4 100G support was first introduced in Paragon-neo Software Revision 11.00.xx. 
 

QSFP56/QSFP-DD Ethernet Ports 

200G QSFP56 
Ethernet ports 

Paragon-neo NRZ 1st gen, 2nd gen, R: n/a For connections to 200G PAM4 
optical interfaces on Ethernet 
devices. Paragon-neo PAM4: P18, P21 

400G QSFP-DD 
Ethernet ports 

Paragon-neo NRZ 1st gen, 2nd gen, R: n/a For connections to 400G PAM4 
optical interfaces on Ethernet 
devices. Paragon-neo PAM4: P18, P21 

 

CFP2 Ethernet Ports 

100G/400G CFP2 
Ethernet ports 

Paragon-neo NRZ 1st gen, 2nd gen, R: n/a Do not connect. 

These ports are not used. Paragon-neo PAM4: P19, P20 

 



  

  Page | 14 

4.3 References Inputs & Outputs 

Calnex recommend that all cables carrying reference signals are as short as possible. ITU G.703 Section 19.2 
states that 50Ω cables carrying 1PPS signal must be less than 3m length to ensure signal integrity. 

Clock Reference Input 

RJ48 Balanced 
Clock Reference 
Input 

Paragon-neo NRZ 1st gen: J2 

Balanced clock reference signals (RJ48): E1, T1, 
64k+8k, 64k+8k+400.  

Pin 1 (Ring), Pin 2 (Tip). All other pins must be left 
unconnected. 

Max differential input voltage: 3.3V. 

AC coupled. 

Input impedance:  
  E1 120Ω differential, 
  T1 100Ω differential, 
  64k+8k, 64k+8k+400 120Ω differential. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J2 

BNC Unbalanced 
Clock Reference 
Input 

Paragon-neo NRZ 1st gen: J1 
Unbalanced clock reference signals: 2.048MHz, 
10MHz, E1. 

Max input voltage:  
  10MHz, 2.048MHz 5Vp-p, 
  E1 3.3Vp-p. 

Input impedance: 
  2.048MHz 50Ω or High Impedance, AC coupled, 
  E1 75Ω AC coupled, 
  10MHz 50Ω or High Impedance, AC coupled. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J1 

 

IMPORTANT  

Paragon-neo allows the option to input balanced and unbalanced clock reference signals. 
Calnex recommend using an unbalanced clock reference signal (BNC connector J1) for the 
best measurement accuracy. 

 

1PPS and ToD Reference Inputs 

RJ48 Balanced 
1PPS and ToD 
Reference Input 

Paragon-neo NRZ 1st gen: J5 

Balanced 1PPS and ToD reference input. 

Pins 3 (–) and 6 (+) 1PPS balanced input. 
Pins 7 (–) and 8 (+) ToD balanced input. 
Pins 4 and 5 ground. 
All other pins must be left unconnected. 

Min input voltage: 0.3V differential. 

Max input voltage: 10V differential. 

ToD and 1PPS inputs are DC coupled. 

Input impedance: 100Ω differential. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J5 

BNC Unbalanced 
1PPS Reference 
Input 

Paragon-neo NRZ 1st gen: J7 Unbalanced 1PPS reference input. 

Max input voltage: 5V DC coupled. 

Threshold voltage adjustable in the GUI. 

Input impedance: 50Ω or High Impedance. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J7 

1PPS reference input pulse timing requirements: 100ns minimum pulse width, 500ms maximum pulse width. 

 

IMPORTANT  

Paragon-neo allows the option to input balanced and unbalanced 1PPS reference signals. Calnex 
recommend using an unbalanced 1PPS reference signal (BNC connector J7) for the best measurement 
accuracy. 

 

https://www.itu.int/rec/T-REC-G.703/en
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Unbalanced Clock Reference Output 

BNC Unbalanced 
Clock Reference 
Output 

Paragon-neo NRZ 1st gen: J3 

Connection to unbalanced clock reference output: 
2.048MHz or 10MHz. 

Output voltage: 
  -1.5/+1.5V High Impedance load, 
  -0.75/+0.75V 50Ω load. 

Output impedance: 
  2.048MHz 50Ω, AC coupled, 
  10MHz 50Ω, AC coupled. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J3 

 

1PPS and ToD Reference Outputs 

RJ48 Balanced 
1PPS and ToD 
Reference Output 

Paragon-neo NRZ 1st gen: J4 

For connection to the reference input of other pieces 
of lab test equipment, or other Paragon-neos. The 
output ToD data cannot be modified.  

Pins 3 (–) and 6 (+) 1PPS balanced output. 
Pins 7 (–) and 8 (+) ToD balanced output. 
Pins 4 and 5 ground. 
All other pins must be left unconnected. 

Output voltage: 2.0V differential, Vcm=2.5Vtyp into 
100Ω load, DC coupled. 

Output drives 100Ω load. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J4 

BNC Unbalanced 
1PPS Reference 
Output 

Paragon-neo NRZ 1st gen: J6 
Connection to unbalanced 1PPS reference output. 

Output voltage: 
  0.6/3.8V High Impedance load, 
  0/1.8V 50Ω load. 

Output impedance: 50Ω DC coupled. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J6 

1PPS reference output pulse width: 20ms. 

 

CAUTION  
The 1PPS and ToD Reference Output connectors are designed for output only. Care must be taken 
when connecting that an input signal is not applied, as this can permanently damage the internal 
circuitry. 
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Test Outputs 

RJ48 Balanced 
1PPS and ToD 
Test Output 

Paragon-neo NRZ 1st gen: J8 

For connection to a 1PPS and ToD input of devices 
under test. The output ToD data can be modified to 
emulate the behavior of a real ToD source. 

Pins 3 (–) and 6 (+) 1PPS balanced output. 
Pins 7 (–) and 8 (+) ToD balanced output. 
Pins 4 and 5 ground. 
All other pins must be left unconnected. 

Output voltage: 2.0V differential, Vcm=2.5Vtyp into 100Ω 
load, DC coupled. 

Output drives 100Ω load. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J8 

BNC Unbalanced 
Clock Test Output 

Paragon-neo NRZ 1st gen: J9 
Connection to unbalanced 10MHz clock test output. 

Output voltage: 
  -1.5/+1.5V high impedance load, 
  -0.6/+0.6V 50Ω load. 

Output impedance: 50Ω AC coupled. 
Paragon-neo NRZ 2nd gen, 
R, PAM4: 

J9 

1PPS test output pulse width: 20ms. 

 

CAUTION  
The 1PPS and ToD Test Output connectors are designed for output only. Care must be taken when 
connecting that an input signal is not applied, as this can permanently damage the internal circuitry. 
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4.4 Measurement Ports 

Calnex recommend that all cables carrying measurement signals are as short as possible. ITU G.703 Section 19.2 
states that 50Ω cables carrying 1PPS signal must be less than 3m length to ensure signal integrity. 

Cable compensation values can be configured in Paragon-neo depending on the measurement running.  Typical 
cable propagation delay values are 4.9ns/m for single-mode optical cables, 4.94ns/m for multimode optical cables 
and 5.1ns/m for electrical cables. Note that these are only typical values and the actual value will differ between 
specific cable types, therefore, for the most accurate cable compensation, the actual propagation delay value for a 
specific cable should be provided by the cable manufacturer or measured by the user. 

 

Clock Frequency Measurement Inputs 

RJ48 Balanced 
T1/E1 Clock 
Frequency 
Measurement Input 

Paragon-neo NRZ 1st gen: P15 

Connection to balanced T1/E1 clock frequency 
measurement input. 

Pins 1 (ring) and 2 (tip) – balanced frequency input. 
All other pins must be left unconnected. 

Max input voltage: 3.3V differential. 

Input impedance: 
  T1 100Ω differential, AC coupled, 
  E1 120Ω differential, AC coupled. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

P13 

BNC Unbalanced 
Clock Frequency 
Measurement Input 

Paragon-neo NRZ 1st gen: P16 

Connection to unbalanced E1 / 2.048MHz / 10MHz / 
25MHz clock frequency measurement input. 

Max input voltage:  
  2.048MHz, 10MHz, 25MHz 5Vp-p, 
  E1 3.3Vp-p. 

Input impedance: 
  2.048MHz, 10MHz, 25MHz 50Ω AC coupled, 
  E1 75Ω AC coupled. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

P15 

 

1PPS and ToD Measurement Inputs 

RJ48 Balanced 
1PPS and ToD 
Measurement 
Inputs 

Paragon-neo NRZ 1st gen: P17 

Connection to balanced 1PPS and ToD 
measurement inputs. 

Pins 3(–) and 6(+) 1PPS balanced inputs. 
Pins 7(–) and 8(+) ToD balanced inputs. 
Pins 4 and 5 ground. 
All other pins must be left unconnected. 

Min input voltage: 0.3V differential. 

Max input voltage: 10V differential. 

Input impedance: 100Ω differential DC coupled. 

Paragon-neo NRZ 2nd gen, 
R, PAM4: 

P14 

BNC Unbalanced 
1PPS Measurement 
Input 

Paragon-neo NRZ 1st gen: P18 Connection to balanced 1PPS measurement input. 

Max input voltage: 5V DC coupled. 

Threshold voltage adjustable in the GUI. 

Input impedance: 50Ω or High Impedance. 
Paragon-neo NRZ 2nd gen, 
R, PAM4: 

P16 

1PPS measurement pulse timing requirements: 100ns minimum pulse width, 500ms maximum pulse width. 

 

IMPORTANT  

Paragon-neo allows the option to input balanced and unbalanced 1PPS measurement signals. 
Calnex recommend using the unbalanced 1PPS measurement port (BNC connector P16/P18) 
to ensure best measurement accuracy 

 

  

https://www.itu.int/rec/T-REC-G.703/en
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4.5 Control & Configuration 

Status Display 

After booting, the Paragon-neo management port IP address is displayed on the LCD Status Display. 

Buttons 

The buttons to the right of the LCD Status Display are used to configure the Paragon-neo management port IP 
address, see section 7 for details. 

LAN (J10) 

This is for connection to the network or a to a PC. The connection to the Paragon-neo LAN control port (RJ45) is 
1GbE.  

USB (J11) 

This is for firmware upgrades via a memory stick and can also be used to power any USB accessories. 

Reset Switch 

Using a pointed implement, gently press the RESET button to return the Paragon-neo to its power-on condition. 
This resets the IP address to factory default. 

Diagnostic Ports J12, J13 – Do Not Connect 

Diagnostic Ports 

Paragon-neo NRZ 1st gen: J12, J13 Do not connect. These ports are 
reserved for diagnostic use by 
Calnex. 

Paragon-neo NRZ 2nd gen, R, 
PAM4: 

J12, J13 

 

 



  

  Page | 19 

5 Rear Panel Description 

 

AC Power Input 

For connection to supplied AC power using the power cord supplied, or one with adequate ratings. See section 
2.2.3 for details of the power requirements.  

 

AC Power Switch 

Use this switch to turn the Paragon-neo AC Input On or Off. 

 

GPS Antenna Input & Output 

The GPS antenna input and output connections are not used. Do not connect. 

 

High-Speed Data Inputs 

The high-speed data input connections are not used. Do not connect. 
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6 Optical Transceivers 

Accurate PTP and SyncE timing measurement requires the use of high-quality optical transceivers (user supplied) 
with Paragon-neo. Transceivers that exhibit high degrees of timing variability should be avoided. 

6.1 Supported NRZ Optical Transceivers 

NRZ transceivers generally exhibit low latency asymmetry that is compensated for by Paragon-neo. Most NRZ 
optical transceivers can be used for PTP timing and SyncE wander measurements. SyncE Jitter testing requires the 
use of specific optical transceivers qualified by Calnex. Qualified transceivers have low inherent jitter and can be 
correctly configured by Paragon-neo to make accurate measurements. 

For the complete list of Calnex-supported optical transceivers please see the relevant section of the Calnex FAQ 
(keyword “optics”) accessed through the support pages at www.calnexsol.com. 

6.2 Supported PAM4 Optical Transceivers 

PAM4 optical transceivers (50G, 100G, 200G and 400G) typically exhibit variable and asymmetric latencies that 
negatively impacts timing measurement accuracy. Therefore, Calnex have qualified specific PAM4 transceivers 
that must be used with Paragon-neo.  

For the complete list of Calnex-supported optics please see the relevant section of the Calnex FAQ (keyword 
“optics”) accessed through the support pages at www.calnexsol.com. 

 

http://www.calnexsol.com/
http://www.calnexsol.com/
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7 Connecting Your Paragon-neo 

You can either connect to Paragon-neo across a network or connect directly to a PC. Paragon-neo instruments 
shipped from Calnex default to obtaining an IP address using DHCP, users can assign a static IP address as 
described below. 

7.1 Connecting Paragon-neo to a Network using DHCP 

1. Connect the AC power cord and switch on Paragon-neo using the rear-panel power switch. 

2. Press the front panel power button to start the instrument. A message appears on the LCD Status Display 
to indicate Paragon-neo is Initialising: 

 

3. Wait for the Paragon-neo to power up and show ‘Obtaining IP …’ on the LCD Status Display. Power-up 
may take 2-3 minutes. 

 

4. Connect an Ethernet cable between the Paragon-neo management port (J10) and your network. 

5. DHCP is enabled by default so Paragon-neo should obtain an IP address on the network. The IP address 
will be displayed on the LCD Status Display. 

 

6. If the DHCP process times out (5 mins) before obtaining an IP address, the default static IP address will be 
used and displayed on the LCD Status Display. New instruments shipped from Calnex have a default 
static IP address of 169.254.1.100. 

7.2 Connecting Paragon-neo to a Network using a Static IP Address 

1. Connect the AC power cord and switch on Paragon-neo using the rear-panel power switch. 

2. Press the front panel power button to start the instrument. A message appears on the LCD Status Display 
to indicate Paragon-neo is Initialising: 

 

3. Wait for the Paragon-neo to power up and show ‘Obtaining IP …’ on the LCD Status Display. Power-up 
may take 2-3 minutes. 
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4. Press the bottom left button next to the LCD Status Display (labelled 'Menu') to show the Main Menu on 
the LCD Status Display. 

 

5. Select the IP menu by pressing the centre button. 

 

6. In the IP menu, select Static IP address by pressing the centre button to clear the ‘Automatic’ checkbox. 

 

7. In the IP menu, use the up, down, left, right and centre buttons to set a Static IP address, address mask 
and gateway address on Paragon-neo. Press the centre button to save the settings. 

 

8. Press the bottom left button once to exit the IP menu and a second time to exit the Main Menu and return 
to the main display. 

 

9. Connect an Ethernet cable between the Paragon-neo management port (J10) and your network. 
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7.3 Connecting Paragon-neo Direct to a PC using a Static IP Address 

1. Follow the steps in section 7.2 to assign a static IP address to Paragon-neo. 

2. Assign a static IP address to your PC Ethernet port that is on the same subnet as Paragon-neo. 
Instructions for setting a static IP address depend on your specific PC, please refer to PC documentation. 

3. Connect an Ethernet cable directly between the Paragon-neo management port (J10) and your PC. 

 

7.4 Browser Access to Paragon-neo GUI 

Once Paragon-neo has an IP address, operation and management of Paragon-neo is through a PC based web 
browser. Browse to the IP address displayed on the Paragon-neo LCD Status Display to see the main Paragon-neo 
GUI. 

Windows 10 and 11 PCs running Edge, Firefox and Chrome browsers are supported, other browsers are not 
precluded. 

See section 12 to enable additional access security.  



  

  Page | 24 

8 Switching On/Off & User Interface Basics 

8.1 Switching On 

Connect the power cord supplied with Paragon-neo to the AC power inlet on the Paragon-neo rear panel (see 
section 5) and switch the power switch next to the AC power inlet. Press the on/off button on the front panel and  
Paragon-neo will start to boot. Once the LCD display shows an IP address, you can connect through a browser, 
see section 7. Boot time may be several minutes. 

8.2 User Interface 

Paragon-neo has embedded software that is pre-installed prior to delivery. No application software is required to 
be installed on your computer.  

To connect to the Calnex Paragon-neo, enter the IP address shown on the front panel status display into your web 
browser address bar to see the user interface shown below. The availability of specific functionality is dependent 
on the fitted hardware and software options. 

 

 

 1  Home 

The Home button will always take you to the Paragon-neo home screen. The Presets panel is displayed by 

clicking on ▼ symbol and closed by clicking the ▲ symbol. 
 

 2  SyncE Wander 

Select if you want to test SyncE Wander up to 400GbE to ITU-T G.8262.1/G.8262. 
 

 3  SyncE Jitter 

Select if you want to test SyncE Jitter up to 100GbE to ITU-T G.8262.1/G.8262. 
 

 4  PTP 

Select if you want to test PTP up to 400GbE in user-defined scenarios. 

For ITU-T testing, the G.8273.2 Conformance Test selection is recommended. 

For O-RAN testing, the O-RAN Conformance Test selection is recommended. 
 

 5   G.8273.2 Conformance Test 

Select if you want to test PTP up to 400GbE to ITU-T G.826x/G.827x standards. 
 

 6  O-RAN Conformance Test 

Select if you want to test PTP up to 400GbE to the O-RAN WG4.CONF 3.3 S-Plane Functional and Performance 

tests standard. 
 

 7  Reset to Defaults 

Resets the Application configuration to default settings.  
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 8  Application 

Select to browse to the main application page to configure and run tests.  
 

 9  System 

Provides information on Serial Number and Options fitted, IP Status, System Status, Error logs. It also enables 
setting of the Time and Date, and shows how to access the file server on the instrument using your browser.  
 

 10  Help 

This provides access to Test Guides, Application Notes, links to ITU-T recommendations and instrument software 
plus licensing information. 

 

8.3 Instrument Shutdown 

The power button icon in the bottom right of the User Interface allows you to switch off or restart the instrument. 

 
 

8.4 Software Version & Instrument Serial Number 

The Paragon-neo instrument serial number and software version information is provided in the Help > About GUI.  
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9 Workflow 

The availability of specific functionality is dependent on the fitted hardware and software options. 

  

 

 1  Instrument Mode 

Selecting the Instrument Mode page allows setup of reference and seed times for Paragon-neo features such as 
PTP and ToD message generation. 

 

 2  Setup Ports 

Selecting the Setup Ports page allows selection and configuration of reference and measurement ports. 

 

 3  Run Apps 

Run Apps is the main instrument control screen where you can setup and start defined synchronization testing. 

 

 4  Status Indicators 

The colors of the status indicators reflect the status of the associated function. 

 
Green: No alarms 

 Red: Current alarm 

 Orange: Historical alarm, now cleared 

 White: Not active in selected Paragon-neo configuration 
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The indicators describe the current state of the following functions: 

Port 1 Link 

Ports 2 Link 

TT-RTE Link 

Indicates physical Ethernet connections to Paragon-neo test ports by detecting 
transitions on the selected port Rx side. 

Port 1 Packets 

Port 2 Packets 

TT-RTE Packets 

Indicates that Paragon-neo is receiving Ethernet packets with no PCS or 
checksum errors. 

Reference Lock 

1PPS Reference 

ToD Reference 

Indicates that Paragon-neo reference inputs are present and locked. The 
references are selected under the Setup Ports key. 

SyncE Lock 

Freq Meas Lock 

Jitter Lock 

1PPS Measurement 

ToD Measurement 

Indicates the presence and lock status of incoming measurement signals. 
Measurements are activated using the applications under the Run Apps key. 

Port 1 FlexE Lock 

Port 1 FlexE MF Lock 

Port 2 FlexE Lock 

Port 2 FlexE MF Lock 

Indicates FlexE frame lock status and FlexE multi-frame (MF) lock status. FlexE 
parameters are configured under Setup Ports → Ethernet → FlexE Settings 

 

 5  Activity Indicators 

Activity Indicators show which of the applications (e.g. PTP Emulation, SyncE Wander, Wander Generation, ESMC 
generation, Background Traffic Generation) under the Run Apps key are currently active. The color provides an 
indication of the status, with green = active, white = inactive. P1 indicates Port1 and P2 indicates Port2. 

 

 6  Measurements 

This area provides the global Start/Stop control for all Wander measurements. Select Start All to start both Port1 
and Port2 Measurements. Select Stop All to stop all active Measurements. 

 

 7  Analysis Tools 

CAT and PFV buttons appear in applications where measurements are made. 

Click CAT to open the Calnex Analysis Tool in a separate tab in your browser. CAT provides graphical Timing 
Analysis measurements and results as well as Pass/Fail performance against selected metrics and masks, for 
example to ITU-T standards. 

Click PFV to open the Protocol Field Verifier in a separate tab in your browser. PFV provides graphical packet 
analysis as well as Pass/Fail performance against selected PTP profiles. 

 

 8  Script Recorder 

The Script Recorder records all key presses and stores them as a script enabling you to cut and paste the 
recorded script into your own programming environment enabling easy automation. Scripts are recorded in tcl and 
Python. 

 

 9  Quick Help 

Quick Help content loads dynamically as you navigate through the various fields in the application. Provides hints 
and help on setting up selected applications and fields including information on the units, resolution and ranges of 
specific fields.   
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10 Example Paragon-neo Workflow 

Connect to the Calnex Paragon-neo by entering the IP address shown on the front panel status display into your 
browser address bar and then the user interface is displayed as shown below: 

From the Workflow keys: 

1. Start the Paragon-neo GUI. 

2. Select a preset test mode e.g. PTP. 

 

 

3. If the test selection requires an absolute time reference, select Instrument Mode from the left-hand side of the 
GUI. The Time Source can be selected and configured to use a predetermined start time, the instrument’s 
internal time, or a Time of Day reference (if connected to Paragon-neo 1PPS/ToD reference port). Press Apply 
after making any changes. 
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4. Click    
 
On the front panel image, click the appropriate Clock Reference and 1PPS ToD Reference selectors for your 
test environment. Configure reference input parameters in the lower panel. Check the reference status 
indicators. 

 

The Quick Help panel is context sensitive and shows help relative to the item in the GUI where the cursor is 
active. 

 

5. On the front panel picture, click the appropriate Ethernet port selectors for connection to your device. 
Configure Ethernet port details input details in the lower panel. Check the Port 1 Link and Port 2 Link status 
indicators. 
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6. Select Run Apps and open/close application panels as required for your test scenario. 

7. Configure the parameters for generation and measurement as required for your test environment then click the 
appropriate Generate and Measure buttons. The buttons turn green and indicate Stop. 

  

 

8. To stop a measurement after running the test, click the  button. 
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9. Click one of the  buttons to display and analyse timing measurements in CAT. 

 

 

10. Click one of the  buttons to open PFV for protocol analysis. 

 

 

Please refer to appropriate Calnex Application Notes and Release Notes for detailed operational steps and result 
interpretation in relation to specific tests. 
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11 Remote Live CAT & PFV 

Remote Live CAT and Remote Live PFV enable the use of standalone CAT and PFV software running on a PC to 
display real-time measurement data from the Paragon-neo, the primary use-case is to provide on-going visibility of 
measurements should the instrument enter “Starvation Mode”. 

Starvation mode is initiated if local resources (memory) on Paragon-neo are depleted due to very long or metric-
intensive measurements being run. In this mode the instances of CAT and PFV on the instrument stop metric 
calculation, message analysis and presentation of new data to the GUI to ensure sufficient resources remain for 
stable operation of the instrument. No measurement data is lost – all captures continue running and measurement 
files are saved. 

Remote Live CAT enables real-time plotting of data and metric calculation regardless of the measurement duration 
or complexity of the configured metrics. 

Remote Live PFV enables real-time analysis of packet flow and PTP profiles. 

Please refer to the detailed instructions provided on the standalone CAT Select File > Remote Live page or the 
standalone PFV Select File > Remote Live page for more details. 

Note – remote file access must be enabled for Remote Live operations, see section 12.2 of this document. 

 

 

IMPORTANT  
Start Remote Live CAT/PFV operations after starting measurements on Paragon-neo and 
disconnect Remote Live CAT/PFV before stopping Paragon-neo measurements. Remote Live 
CAT/PFV polls the measurement files on Paragon-neo so analysis errors may result if data files 
have been closed on Paragon-neo. 
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12 Access Security 

12.1 Using Secure Connections to Paragon-neo 

The Paragon-neo GUI is accessed with a web browser using either HTTP or HTTPS connections. The default 
setting is that both protocols are enabled, users may disable HTTP and force HTTPS access for enhanced network 
security. Calnex provide a default security certificate that enables an HTTPS encrypted connection without 
authentication.  

Users must replace the Calnex certificate with an organization specific signed certificate to enable encrypted and 
authenticated HTTPS connections. Configuration and security certificate management is controlled through the 
System > Setup screen: 

 

 

Note: Paragon-neo does not redirect HTTP connection requests to HTTPS if HTTP is disabled, and vice versa. The 
connection will timeout and fail. 

CAT and PFV windows follow the same security protocol that is used when you access the main Paragon-neo GUI. 

 

 

CAUTION 

If your Paragon-neo must be returned to Calnex for jitter calibration or maintenance, please 
remove any security certificates that have been loaded. 

 

Clicking the Delete PEM File button will permanently delete any PEM file that you have installed, overwriting it with 
the Calnex default PEM file data. 
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12.2 Samba Remote File Access 

Remote access to settings files, measurements and impairment files is provided by Paragon-neo using Samba, 
allowing PCs to connect using the SMB/CIFS protocol.  

Samba also enables the Remote Live CAT function, see section 11. 

By default, Samba is enabled on Paragon-neo, it can be enabled and disabled through the System > Setup screen: 
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13 Paragon-neo Option 133 1PPS/ToD/Frequency Converter 

 

The Calnex external 1PPS/ToD/Frequency converter may be purchased as an option to use with Paragon-neo. 

 

 

Function Input Output 

Split balanced 1PPS+ToD signals to 
separate unbalanced 1PPS and ToD 
RS232 signals 

RJ48 connector port 1. 

Balanced 1PPS and RS422 ToD. 

Unbalanced 1PPS on RJ48 
connector (port 2) and on BNC 
(port 7).  

ToD RS232 signal on DB9 
connector (port 6). 

Convert ToD RS232 signal to RS422 RS232 on DB9 connector (port 6) RS422 on RJ48 connector (port 4) 

Convert unbalanced 1PPS signal to 
balanced 1PPS signal 

Unbalanced 1PPS on RJ48 
connector (port 3) 

Balanced 1PPS on RJ48 connector 
(port 4) 

Frequency conversion. 

See picture below for conversion 
options. 

BNC connector (port 5) BNC connector (port 8) 

 

Size:   140 x 35 x 105 mm. 
Weight:   320g. 
Power Supply:   USB 5V DC / 3W.  
Environmental Specifications:   Same as Paragon-neo.  

 

The peak-peak frequency input to the converter should be in the range of 200mV–3V into 50Ω. The converter can 
accept either sinusoidal or square waveform. The frequency output is 1.5Vp-p square wave into 50Ω.  

The POWER GOOD LED is on when power is supplied to the converter. There is no power switch. Power can be 
supplied from an active USB port.  

Switches SW1 and SW2 are the only controls on the device. Set these switches according to the table printed on 
the rear panel and desired input/output frequencies.  
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To reduce sources of inaccuracy Calnex recommend that 1PPS measurement signals are not passed through the 
converter. If 1PPS measurement signals are passed through the converter, great care must be exercised to 
determine the precise propagation delay and add this into the cable compensation value in Paragon-neo. 

If the precise port-to-port propagation delays are not printed on the converter, a method to determine the delays is 
provided in the Calnex FAQ (keyword “Option 133”) accessed through the support pages at www.calnexsol.com. 

http://www.calnexsol.com/
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14 Help and Support 

A Quick Help panel appears on the left side of the Paragon-neo GUI giving definitions of parameters and settings 
that the cursor is hovering over. 

Release notes, test guides and application notes can be found by clicking the Help button in the top right corner of 
the GUI. 

The Calnex Support Website (https://calnexsol.com/support/) is a gateway for additional information and support: 

• The Calnex Product FAQ provides help using various aspects of Paragon-neo. The FAQ is searchable. 

• Browse a library of application notes, test guides, articles, and blogs. 

• Download software updates. 

• Access the Calnex support ticket system. 
 
Contact your local Calnex representative for further support using one of the email addresses below. 
 

Region Email 

Americas support.americas@calnexsol.com  

Europe, Middle East, Africa support.emea@calnexsol.com  

India support.india@calnexsol.com  

Japan support.japan@calnexsol.com  

China support.greaterchina@calnexsol.com 

Southeast Asia and Australasia support.sea@calnexsol.com 

Korea support.korea@calnexsol.com 

Other support@calnexsol.com 

 

When contacting Calnex, please include your Paragon-neo serial number and software version that it is running. 
These details can be found on the Help > About screen: 

 

14.1 Diagnostic Log Files 

Calnex may request that users supply the Paragon-neo diagnostic log files to help with support provision.  A zip file 
of diagnostic logs can be taken from Paragon-neo by clicking the Diagnostics button on the Help > Support GUI 
page: 

 

This function creates and downloads .zip file containing the full diagnostics logs from the Paragon-neo into the 
local browsers default “Downloads” folder. 

  

https://calnexsol.com/support/
https://calnexsolutions.atlassian.net/wiki/spaces/KB/overview
mailto:support.americas@calnexsol.com
mailto:support.emea@calnexsol.com
mailto:support.india@calnexsol.com
mailto:support.japan@calnexsol.com
mailto:support.greaterchina@calnexsol.com
mailto:support.sea@calnexsol.com
mailto:support.korea@calnexsol.com
mailto:support@calnexsol.com
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